Tutorials 2 & 3 Take-Home Test: Microsoft Word

Course: Word Processing
Instructor: Ms. Ann Gordon Semester: Fall 1998
Name Date

Directions: Answer as many questions as you can without opening your textbook. You may refer to your textbook
for any questions you cannot answer. This Take-Home Test must be handed in next Wednesday and will not be
accepted late.

Multiple Choice Questions:

1. To open an existing document, click the Open button on the:
a. Standard toolbar
b. Formatting toolbar
c. Status bar
d. Vertical scroll bar

2. One way to move the insertion point is to:
a. Click Exit on the menu bar
b. Point and click the pointer in another part of the document
c. Press the Shift key
d. All of the above

3. To move the insertion point to the beginning of the current line, press:
a. [Home]
b. [Ctrl] + [Home]
c. [PageUp]
d. [Ctrl] + [PageUp]
4.  To move the insertion point down one paragraph at a time, press:
a. down arrow
b. [Ctrl] + down arrow
c. [Alt] + down arrow
d. [Alt] + [Ctrl] + down arrow

5. To select a paragraph,
a. Press the [Ctrl] key and click in the selection bar, or triple-click in the selection bar
b. Double-click in the selection bar next to the paragraph, or triple-click within the paragraph
c. Press the [Ctrl] key and click within the paragraph
d. Double-click the paragraph

6. To select a line,
a. Click and drag in the selection bar next to the line
b. Press the Control key and click within the line
¢. Double-click within the line
d. Click in the selection bar next to the line
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10.

11.

12.

13.

14.

15.

MS Word's "select, then do" feature allows you to select a block of text and then:
a. Delete the block

b. Move the block

c. Format the block

d. All of the above

To select a word in a document:

a. Click in the selection bar next to the line containing the word
b. Press the [Ctrl] key and click within the word

c. Double-click the word

d. Press the [Alt] key and click within the word

To select the entire document, do which of the following:

a. Press and hold the Control key and click in the selection bar, or triple-click in the selection bar
b. Double-click the vertical scroll box

c. Click and drag in the selection bar next to the document

d. Click in the selection bar next to the document

To reverse the very last change you made to a document, click the:
a. Redo button
b. Undo button
c. Save button
d. Paste button

You can reverse the action of the Undo command by using:
a. Save As

b. Close

c. Redo

d. Reformat

Removing text or a graphic from a document and placing it on the Clipboard is called:
a. Dragging

b. Dropping

c. Cutting

d. Pasting

The quickest and easiest way to locate a particular word or phrase in a document is to use the:
a. Replace command

b. Find command

c. Lookup command

d. Search command

Transferring a copy of the text from the Clipboard into a document at the insertion point is called:
a. Pasting

b. Copying

c. Cutting

d. Selecting

Margin settings for the entire document can be changed with the:
a. Margins command

b. Page Setup command

c. Layout command

d. Formatting command
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16.

17.

18.

19.

20.

21.

22.

23.

For the top and bottom margins, MS Word uses the default setting of:
a. linch

b. 2 inches

c. 1.5 inches

d. 1.25 inches

To quickly indent a single paragraph, you can use the:
Increase Indent button

Decrease Indent button

Justify button

Center button

aoe o

A font that does not have the small horizontal lines at the tops and bottoms of letters is called:
a. A roman font

b. A sans serif font

c. An italic font

d. A title font

Which of the following is ONE way to change the font of selected text?

a. Click the Font button on the Standard toolbar and then select the desired font from the pop-up menu.

b. Click the Font list arrow on the Standard toolbar to display the list of fonts and then select the desired font.

¢. Double-click the mouse button and then select the desired font from the pop-up menu.

d. Click the Font list arrow on the Formatting toolbar to display the list of fonts and then select the desired
font from the list.

When you want to emphasize a list of items, you can use:
Characters and tabs

Nonprinting characters

Bullets or numbers

None of the above

ae o

A text's vertical spacing is also referred to as:
a. Tabs

b. Alignment

c. Justification

d. Line spacing

In Figure 2-4, item number 5 identifies the:
a. Bold button

b. Italic button

c. Underline button

d. None of the above

In Figure 2-4, item number 3 identifies the
a. Bold button.

b. TItalic button.

c. Underline button.

d. none of the above.
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Figure 2-4
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24. In Figure 2-4, item number 4 identifies the:
a. Bold button
b. Italic button
c. Underline button
d. None of the above

25. To divide a document into sections, insert a:
Page break

b. Column break

c. New paragraph

d. Section break

®

26. What unit or part of a document can have its own page orientation, margins, headers, footers, and vertical

alignment?

a. Page

b. Column
c. Section

d. Paragraph

27. Ifyou want a vertical alignment change to affect only one section of your document, be sure the ‘Apply to’ list
box is set to:
a. First section
b. All sections
c. This page
d. This section

28. Vertical alignment specifies how a page of text is positioned on the page between the:
a. Left and right margins
b. Top and bottom margins
c. Page breaks
d. Section breaks
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29.

30.

31.

32.

33.

To change the vertical alignment of a section, click , click Page Setup, and then click the Layout

tab.

a. File
b. Edit
c. View
d. Insert

To see exactly how a header will appear on the printed page, you can switch to:

Normal view
Online layout view
Outline view

Page layout view

/eo o

If Annie clicks item number 9 in Figure 3-2 below, she will close the:

a. Document

b. MS Word application

c. Footer section

d. Header and Footer toolbar

In Figure 3-2, item 5 is:

a. Show/Hide Document Text button
b. Show Next button

c. Same as Previous button

d. Insert Page Number button

Clicking item item 8 in Figure 3-2 will:

Display the header area for the previous section
Display the header area for the next section
Close the Header and Footer toolbar

Insert the page number into the header

aoe o

Figure 3-2
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34.

35.

36.

37.

38.

39.

40.

41.

Word Processing with MS Word

In Figure 3-2, item 1 is pointing to the:
a. Header box

b. Header area

c. Footer area

d. Insertion box

In Figure 3-2, item 6 is pointing to which button?
a. Show/Hide Document Text

b. Show Next

c. Same as Previous

d. Insert Page Number

In Figure 3-2, item 2 is pointing to the:
a. Header and Footer toolbar

b. Insert Header toolbar

¢. Header toolbar

d. Formatting toolbar

MS Word provides templates for formatting:
a. Reports

b. Brochures

c. Letters

d. All of the above

The first step in applying a template's styles to a document is to:

a. Highlight individual parts of the document

b. Select the appropriate style from the Style list on the Formatting toolbar
c. Select the appropriate template from the Template list in the Style Gallery dialog box

d. None of the above

Information arranged in horizontal rows and vertical columns is called a:

a. Cell

b. Table

c. Document
d. Report

The MS Word feature that computes the totals of numeric columns in a table is called:

a. AutoSum

b. Number Format
c. Table Formula
d. AutoAdd

To add a gray or colored background to document text, you select the text, click Format on the menu bar, and

then click:

a. Graytone Background
b. Table Shades

c. Borders and Shading
d. None of the above
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TRUE - FALSE QUESTIONS

1. To vertically align a section, you first select Page Setup from the File menu.
a. True
b. False

2. Vertical alignment refers to how a page of text is positioned on the page between the left and right margins.
a. True
b. False

3. You cannot see headers in normal view.
a. True
b. False

4.  The current paragraph is the paragraph where the cursor is located.
a. True
b. False

5. A template is a set of predefined styles designed for a specific type of document.
a. True
b. False

6.  You can enter text in a table by moving the insertion point into a cell and typing.
a. True
b. False

7. Just like in a paragraph, you must select text within a table in order to edit it.
a. True
b. False

8. To rename a file, select Save As from the File menu.

a. True
b. False
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	Course: Word Processing
	To open an existing document, click the Open button on the:
	Standard toolbar
	Formatting toolbar
	Status bar
	Vertical scroll bar

	One way to move the insertion point is to:
	Click Exit on the menu bar
	Point and click the pointer in another part of the document
	Press the Shift key
	All of the above

	To move the insertion point to the beginning of the current line, press:
	[Home]
	[Ctrl] + [Home]
	[PageUp]
	[Ctrl] + [PageUp]

	To move the insertion point down one paragraph at a time, press:
	down arrow
	[Ctrl] + down arrow
	[Alt] + down arrow
	[Alt] + [Ctrl] + down arrow

	To select a paragraph,
	Press the [Ctrl] key and click in the selection bar, or triple-click in the selection bar
	Double-click in the selection bar next to the paragraph, or triple-click within the paragraph
	Press the [Ctrl] key and click within the paragraph
	Double-click the paragraph

	To select a line,
	Click and drag in the selection bar next to the line
	Press the Control key and click within the line
	Double-click within the line
	Click in the selection bar next to the line

	MS Word's "select, then do" feature allows you to select a block of text and then:
	Delete the block
	Move the block
	Format the block
	All of the above

	To select a word in a document:
	Click in the selection bar next to the line containing the word
	Press the [Ctrl] key and click within the word
	Double-click the word
	Press the [Alt] key and click within the word

	To select the entire document, do which of the following:
	Press and hold the Control key and click in the selection bar, or triple-click in the selection bar
	Double-click the vertical scroll box
	Click and drag in the selection bar next to the document
	Click in the selection bar next to the document

	To reverse the very last change you made to a document, click the:
	Redo button
	Undo button
	Save button
	Paste button

	You can reverse the action of the Undo command by using:
	Save As
	Close
	Redo
	Reformat

	Removing text or a graphic from a document and placing it on the Clipboard is called:
	Dragging
	Dropping
	Cutting
	Pasting

	The quickest and easiest way to locate a particular word or phrase in a document is to use the:
	Replace command
	Find command
	Lookup command
	Search command

	Transferring a copy of the text from the Clipboard into a document at the insertion point is called:
	Pasting
	Copying
	Cutting
	Selecting

	Margin settings for the entire document can be changed with the:
	Margins command
	Page Setup command
	Layout command
	Formatting command

	For the top and bottom margins, MS Word uses the default setting of:
	1 inch
	2 inches
	1.5 inches
	1.25 inches

	To quickly indent a single paragraph, you can use the:
	Increase Indent button
	Decrease Indent button
	Justify button
	Center button

	A font that does not have the small horizontal lines at the tops and bottoms of letters is called:
	A roman font
	A sans serif font
	An italic font
	A title font

	Which of the following is ONE way to change the font of selected text?
	Click the Font button on the Standard toolbar and then select the desired font from the pop-up menu.
	Click the Font list arrow on the Standard toolbar to display the list of fonts and then select the desired font.
	Double-click the mouse button and then select the desired font from the pop-up menu.
	Click the Font list arrow on the Formatting toolbar to display the list of fonts and then select the desired font from the list.

	When you want to emphasize a list of items, you can use:
	Characters and tabs
	Nonprinting characters
	Bullets or numbers
	None of the above

	A text's vertical spacing is also referred to as:
	Tabs
	Alignment
	Justification
	Line spacing

	In Figure 2-4, item number 5 identifies the:
	Bold button
	Italic button
	Underline button
	None of the above

	In Figure 2-4, item number 3 identifies the
	Bold button.
	Italic button.
	Underline button.
	none of the above.

	In Figure 2-4, item number 4 identifies the:
	Bold button
	Italic button
	Underline button
	None of the above

	To divide a document into sections, insert a:
	Page break
	Column break
	New paragraph
	Section break

	What unit or part of a document can have its own page orientation, margins, headers, footers, and vertical alignment?
	Page
	Column
	Section
	Paragraph

	If you want a vertical alignment change to affect
	First section
	All sections
	This page
	This section

	Vertical alignment specifies how a page of text is positioned on the page between the:
	Left and right margins
	Top and bottom margins
	Page breaks
	Section breaks

	To change the vertical alignment of a section, click __________, click Page Setup, and then click the Layout tab.
	File
	Edit
	View
	Insert

	To see exactly how a header will appear on the printed page, you can switch to:
	Normal view
	Online layout view
	Outline view
	Page layout view

	If Annie clicks item number 9 in Figure 3-2 below, she will close the:
	Document
	MS Word application
	Footer section
	Header and Footer toolbar

	In Figure 3-2, item 5 is:
	Show/Hide Document Text button
	Show Next button
	Same as Previous button
	Insert Page Number button

	Clicking item item 8 in Figure 3-2 will:
	Display the header area for the previous section
	Display the header area for the next section
	Close the Header and Footer toolbar
	Insert the page number into the header

	In Figure 3-2, item 1 is pointing to the:
	Header box
	Header area
	Footer area
	Insertion box

	In Figure 3-2, item 6 is pointing to which button?
	Show/Hide Document Text
	Show Next
	Same as Previous
	Insert Page Number

	In Figure 3-2, item 2 is pointing to the:
	Header and Footer toolbar
	Insert Header toolbar
	Header toolbar
	Formatting toolbar

	MS Word provides templates for formatting:
	Reports
	Brochures
	Letters
	All of the above

	The first step in applying a template's styles to a document is to:
	Highlight individual parts of the document
	Select the appropriate style from the Style list on the Formatting toolbar
	Select the appropriate template from the Template list in the Style Gallery dialog box
	None of the above

	Information arranged in horizontal rows and vertical columns is called a:
	Cell
	Table
	Document
	Report

	The MS Word feature that computes the totals of numeric columns in a table is called:
	AutoSum
	Number Format
	Table Formula
	AutoAdd

	To add a gray or colored background to document text, you select the text, click Format on the menu bar, and then click:
	Graytone Background
	Table Shades
	Borders and Shading
	None of the above

	To vertically align a section, you first select Page Setup from the File menu.
	True
	False

	Vertical alignment refers to how a page of text is positioned on the page between the left and right margins.
	True
	False

	You cannot see headers in normal view.
	True
	False

	The current paragraph is the paragraph where the cursor is located.
	True
	False

	A template is a set of predefined styles designed for a specific type of document.
	True
	False

	You can enter text in a table by moving the insertion point into a cell and typing.
	True
	False

	Just like in a paragraph, you must select text within a table in order to edit it.
	True
	False

	To rename a file, select Save As from the File menu.
	True
	False


